
The Cranky Man's Concise Guide ​
to ​

EP Audio Editor 
(Or: How to Stop Sucking at Multi-Sampling) 

 
"DAWless. Just you and the machine, pure creativity." Hahahaha!​

 

If you're here, it's because you've realized that "DAWless" actually means "squinting at a 
seven-segment display while your ‘vast’ 64MB of free RAM screams for mercy." 

You've got a pile of gear that looks like a props department from a 1980s sci-fi film, and a folder 
of WAV files that your hardware refuses to acknowledge. Welcome to my world. 

Why Does This Exist? (The "Hardware Purgatory" 
Problem) 
Look, we all bought the EP because it looks like a calculator from the 70s and makes us feel like 
we're in a Kraftwerk video. (Okay, I described myself)  But then you try to slice a drum break on 
that tiny screen, and suddenly the "magic" is gone. 

Here is the cold, hard truth: 



1.​ You have 64MB. In a world of terabyte SSDs, that's like trying to fit a grand piano into 
your pants pocket. I did try. Not pretty. 

2.​ The upload limit is 20 seconds per sample. Don't argue with me, argue with the 
firmware or people in Sweden. 

3.​ The hardware cannot create Multi-samples at this moment. It just can't. There is no 
function for it. 

EP Audio Editor is the bridge. It’s the grumpy old man standing between your messy computer 
and your fancy hardware, ensuring the audio is chopped, resampled, and shoved into the right 
slots before you have a mid-life crisis. 

 

1. Getting Started: The Interface 

The "Layer Cake" 
The screen is divided into three sections. Try to keep up. 

1.​ Top Bar (The Region Bar): The colored blocks at the top. These are your actual 
samples. 

○​ Drag the vertical lines to change where a sample starts and ends. 
○​ Right-Click here to split regions or delete them. 

2.​ Middle (The Waveform): The squiggly lines. If you see a flat line, you recorded silence. 
Good job. 

○​ Scroll Wheel: Zooms. (Unless you changed it in settings, you rebel). 
○​ Alt + Scroll: Scrolls sideways. 

3.​ Bottom (The Piano Roll): The piano keys. 
○​ This maps the sample to the MIDI notes. 
○​ Drag the edges of the colored zones to change which keys trigger the sample. 
○​ Double-Click the piano area to expand it if your eyesight is failing. 
○​ Where you click on the piano key determines if it overlaps or pushes.  

 



Tool Modes (How to Click on Things) 
The toolbar changes what your mouse does. If you click and nothing happens, you're holding 
the wrong tool. 

●​ Normal Tool (Arrow): 
○​ Click: Moves the playhead. 
○​ Ctrl + Drag: Creates a Loop/Selection. 
○​ Drag Edges: Context-sensitive. Dragging in the Region header resizes the 

region. Dragging a selection edge resizes the selection. 
●​ Paint Levels (The Paintbrush): 

○​ Literally draw volume curves on your waveform. Want a fade-out? Draw a line 
down. Want a side-chain effect? Draw a scoop. It’s crude, destructive, and 
effective. 

●​ Selection Tool (I-Beam): Like the normal tool, but you don't have to hold Ctrl to select. 
For lazy people. 

●​ Rearrange Tool (The Green Monster): 
○​ Moves the audio inside the selection without moving the selection itself. 
○​ Ctrl + Drag: Copies the audio. 
○​ Alt + Drag: "Ripple" edit. It shoves the rest of the audio over so you don't leave a 

gap. 
○​ Shift + Drag - Mix the audio with whatever you drag it over. Luckily we don’t have 

more modifier keys or I’d use them all. 
●​ Time Stretch Tool: 

○​ Drag the Right Handle of a selection to stretch it. It has a circle. That’s where 
you click and drag. 

○​ Hold Alt: Stretch In-Place. It keeps the length of the file the same but warps the 
selection only. 

●​ Retime Tool: 
●​ What it does: Unlike Time Stretch (which changes the length), this keeps the 

total length of the region exactly the same. If you drag the circle handle, it 
compresses the left side and expands the right side (or vice versa). 

●​ Why? You recorded a guitar riff. The first note was too fast, the second was too 
slow, but the total time was correct. This fixes your bad playing without ruining 
the loop length. Especially useful if this is a loopable loop.  

 
 

Editing & "Audio Hygiene" 

Fixing Your Bad Recordings 



Your recording has hiss, hum, and breathing noises. The EP hates that. 

Note: Most of these tools work on the Selection (the red box you create when you hold Ctrl + 
Drag) or on the whole audio if no selection is made. You will find most of these tools in the menu 
Audio.  

Fixing Quality 

●​ Adaptive Noise Gate: Automatically silences the parts where you aren't playing. It 
listens to the "Noise Floor" and clamps down. Use it on drum breaks. 

●​ Adaptive Compressor: Makes the quiet parts loud and the loud parts quiet. 
●​ Spectral Isolation and Cleanup: Black magic math. It looks for things in the spectrum 

that shouldn’t be there. The result is often a “better recording” as noise and natural 
reverb can be suppressed.  

●​ Remove All Silences (menu Region): Scans the file and physically deletes the gaps.  

Creative Transitions (Fading into the Abyss) 
Standard fades are boring. Use these instead. 

●​ Fade Out to Reverb / Delay: 
○​ Menu: Audio -> Fade Out to Reverb / Fade Out to Delay 
○​ What it does: Instead of fading to silence, it fades the audio out while 

simultaneously feeding it into a reverb or delay tank. The result is a natural 
"ringing out" tail. 

○​ Why? Use this on the end of a chopped loop so it doesn't sound like it was cut 
with a guillotine. 

The "I'm Feeling Lazy" Automation 
Tools designed for people who don't want to set parameters manually. 

●​ Create Single Region Instrument (+Pitch): 
○​ Menu: Region -> Create Single Region Instrument... 
○​ What it does: It selects the whole file, creates a region, detects the pitch 

automatically, sets the Root Note, and finds a loop point. It does 4 minutes of 
work in 4 seconds or so.. 

●​ Estimate Pitch: 
○​ Menu: Selection -> Estimate Pitch 
○​ What it does: Tells you what note is playing in your selection. 
○​ Why? Because you can't tell the difference between C# and D, and you're too 

embarrassed to ask. 
●​ Tune / Repitch: 

○​ Menu: Audio -> Tune/Repitch... / Audio -> Auto-Tune to Root 



○​ What it does: Auto-Tune forces the sample to the nearest perfect semitone. 
Tune/Repitch lets you manually fine-tune by cents. 

○​ Why? Your analog synth drifts. Or your turntable was fast. Fix it before you load 
it. 

Fringe Editing Tools (For the Obsessive-Compulsive) 
●​ Paste in Place: 

○​ Menu: Edit -> Paste in Place 
○​ What it does: Standard Paste inserts audio and pushes everything else to the 

right (like a ripple). Paste in Place overwrites the audio exactly where the cursor 
is, without moving the rest of the file. It’s destructive. Be careful. 

●​ Delete Everything Outside Loop: 
○​ Menu: Selection -> Delete everything outside 
○​ What it does: The "Crop" button. It deletes the intro and the outro and leaves you 

with just the loop. 
○​ Why? Because you downloaded a 3-minute song just to sample 2 seconds of a 

breakbeat. 
●​ Append Wav: 

○​ Menu: File -> Append Wav... 
○​ What it does: Glues another WAV file onto the end of your current one. 
○​ Why? You want to build a "Drum Chain" (Kick, Snare, Hat all in one file) 

manually. 

 

Settings & View Options 
●​ Trim to EP limits (~20s): 

○​ Menu: Settings -> Trim to EP limits 
○​ What it does: If you try to save a file longer than ~20 seconds, it chops the end 

off. 
○​ Why? To save you from the error message when you try to upload it. 

●​ Show Loupe: 
○​ Menu: Settings -> Show loupe when dragging 
○​ What it does: Shows a magnified bubble under your mouse cursor when you 

drag loop points. 
○​ Why? Because you refuse to zoom in, and your monitor is too far away. 

●​ Play Animation on Empty Screen: 
○​ Menu: Settings -> Play animation... 
○​ What it does: Bounces stupid balls around when no file is loaded. 
○​ Why? I got bored coding DSP algorithms and wanted to do some physics math. 

Leave it on, it looks cool and I literally spent like 2 nights on it. 



 

 

Looping within the Region (The Cycle of Madness) 
A region can have a specific looping point. However, simply creating the Red Selection (Ctrl + 
Drag) is not enough. That’s just a preview area for you to audition the loop. 

Important: To commit the current selection as the actual loop for the sample, you must click the 
"Apply to Region Loop" button in the Right Panel (under the "Region" tab). 

Making a perfect loop is hard. The software tries to save you. 

●​ Snap to Zero Crossing: (Toggle in Selection Menu). Forces your cursor to land where 
the waveform crosses the center line. Leave this on unless you enjoy hearing a 
"CLICK" every time. 

●​ Find Optimal Loop in the menu Selection: The computer analyzes the audio under the 
selection and finds the most seamless loop point for you. There are numerous methods 
how the system tries to find an optimal loop within the selection. Neither of them is the 
magic pixie dust that works on every sound, but it can narrow the searching place. 

●​ Crossfade Loop in the menu Selection: Blends the end of the loop point into the start. 
This is usually what sells smooth looping. 

○​ Equal Power: Keeps the volume consistent. 
○​ Hanning: Smoother, good for ambient pads. 

 

Chopping & Mapping  

1. Auto-Chop 

●​ One-Shot Chop: Detects transients (drum hits). Good for breaking beats. 
●​ Melodic Chop: Detects Pitch. It tries to find where the note changes. Use this for 

basslines or vocal melodies. 
○​ Warning: The EP hardware supports a maximum of 8 Regions. If the Auto-Chop 

finds 42 slices, you’re going to have a bad time. Delete the ones you don't need. 

2. Distribute Notes 

You created a few regions. Great. Now, where do they go? 

●​ Distribute Notes (Percussive / One-Shot):​
This forces your messy chops onto a strict musical grid (Chromatic, Major, Minor, etc.). 



○​ Why use this? If you select "C Major," it maps your drums only to the white keys. 
○​ The "Anti-Silence" Feature: It automatically fills the "dead keys" between your 

notes. If your kick is on C3 and your snare is on E3, hitting D3 won't give you 
silence: it will trigger the snare pitched down (or the kick pitched up). It’s sloppy, 
but it keeps the beat going. 

●​ Distribute Notes (Melodic):​
You were too lazy to sample every key (well, you really can’t with just 8 regions), so you 
sampled a C3 and a G3. This tool stretches them to cover the notes you missed (D, E, 
F). 

○​ Root Calculation: The software can auto-detect the pitch of your regions if you 
didn't set the Root Notes manually. 

○​ Distribution Bias (The Important Part): You choose which sample does the heavy 
lifting: 

■​ Center: Splits the difference. Fair, but boring. 
■​ Sample Upwards (Low Bias): The lower sample stretches up to cover 

the gap. Result: The Chipmunk Effect. 
■​ Sample Downwards (High Bias): The higher sample stretches down to 

cover the gap. Result: The Darth Vader Effect. (Usually sounds better for 
bass). 

3. Manual Mapping & The "Secret" Overlap 

Menu Path: View -> Edit Key Boundaries (or just Double-Click the Piano Roll) 

Sometimes the automated tools aren't enough. You want to manually drag the split points 
between your samples. You want Region 1 on C4 and Region 2 on C#4. 

The Piano Roll at the bottom is interactive, but it has a split personality: 

1.​ The Shove (Standard Drag): 
○​ Click and drag the BOTTOM HALF of the vertical boundary line between two 

regions. 
○​ Result: As you drag right, you push the next region forward. They stay adjacent. 

No gaps, no overlaps. Orderly. 
2.​ The Overlap (The Diagonal Layer): 

○​ Click and drag the TOP HALF of the boundary line. 
○​ Result: The line turns Diagonal. 
○​ What it means: You have now stacked two regions on the same key. Region A 

ends on C4, and Region B also starts on C4. 
○​ Why do this? Well, EP is picky about this which I assume is due to a firmware 

bug. You actually want to have overlapped regions, otherwise EP might decide to 
slightly rewrite the regions by itself.  

●​ The "Accordion" Move: Hold Ctrl while dragging a boundary. It stretches/shrinks all 
subsequent regions relative to your movement. Good for fixing a mapping that is off by a 
mile. 



 

Resampling & Memory Management 
Fitting 10 seconds of audio into 5 seconds of memory. 

You have 128 MB and it is already 98% full. That is pathetic. You need to save space. Here are 
the tools to do it. 

1. The Repitch Tricks 

●​ Double Time (+12 semitones): The "Nuclear Option." Plays audio at 2x speed. Saves 
50% of your memory. 

●​ SP-1200 Repitch (+5 semitones): Resamples audio up by ~1.33x speed. The software 
sets the instrument's Global Pitch to -5. The hardware plays it slower, restoring the 
original pitch. This simulates the old DJ trick of sampling an LP at 45 RPM to save 
sampling time. 

Incidentally, this will allow you to break the 20 sec maximum rule per sample to 40 seconds per 
sample.  

2. Sample Rate Surgery (The Diet Plan) 

If you don't want to change the pitch/speed, you can just lower the quality. 

●​ Resample to 46.875kHz (Medieval/Native): 
○​ What it is: The exact, native sample rate of the EP Medieval hardware. 
○​ Why use it? If you upload a 48kHz file, the EP software will need to convert it. If 

you use this, the EP Medieval plays it exactly as is. Maximum transparency. 
●​ Downsample to 44.1kHz: 

○​ Why? Because you recorded at 96kHz like you're Hans Zimmer, but you're 
putting it on a toy calculator. Stop it. Just stop it. You are not Hans. 

●​ Downsample to 22kHz: 
○​ What it is: Cuts the file size in Half. 
○​ The Cost: You lose all frequencies above 11kHz. 
○​ Use for: Kick drums, basses, electric pianos. Anything that doesn't need 

"sparkle." 
●​ Downsample to 16kHz (Voice Mode): 

○​ What it is: The "Telephone" setting. 
○​ Use for: Vocal chops, speech quotes, and lo-fi textures. Do not use this on 

cymbals unless you want them to sound like sand. 

3. The "Desperate Measures" (Combo Moves) 



For when you have 0.5MB left and a dream. 

●​ Downsample to 22kHz + Double Time: Combines the 2x speedup with half-sample 
rate. Result: 25% of original size. Amazing? Well… 

●​ Downsample to 16kHz + Double Time: The smallest possible file size. It will sound 
crunchy. Wear it like a badge of honor 

 

The "Weird" Stuff (DSP Effects) 
For when you run out of musical ideas. 

●​ The Infinite Sustain Synth: performs a medical procedure on your audio. It finds the 
"DNA" of the sound (a single waveform cycle), clones it, and repeats it infinitely. It turns 
any organic sample into a static oscillator. 

●​ Granular Cloud: Takes a loop and turns it into a swarm of bees. 
●​ Frequency Cloud (PaulStretch): Makes a 1-second burp last 20 minutes. Sounds like 

heavenly choirs or nightmares, depending on the source. It’s actually interesting to set 
the stretch to 1x, set the Loop Length to 100% and change Window to get a different 
sound from the selection. A clap can sound like an ocean and a drum like a bag of rocks. 

●​ Morpher (Spectral Loop Stabilizer): So, you used the Infinite Sustain Loop tool, and 
you complained that it "sounds too much like a Nintendo." Fine. You want the stability of 
a synthesizer but the texture of your real sample. The Morpher does the exact same 
thing as the The Infinite Sustain Synth tool: it finds a perfect waveform cycle ("The 
Robot"), but instead of just mixing it, it performs a Spectral Transplant. It forces the 
texture and timbre of your original sample (The "Human") onto the perfect, unmoving 
pitch of the Robot. 

●​ Micro Synth: Generates a simple synthesized beep inside your selection. For when you 
need a test tone or a sub-bass sine wave and can't be bothered to plug in a synth. Ok, 
fine, I went a bit off the script here. 

How to Use The Infinite Sustain Synth 

You sampled a bass guitar, but it fades out after 2 seconds. You want it to hold forever like a 
synthesizer. You tried looping it, but it wobbles like a drunk sailor. 

1.​ Select a Region: Loop a steady part of the note (the sustain). 
2.​ Open the Tool: It calculates a "Robot" buffer (the perfect mathematical loop) and a 

"Human" buffer (your original wobbly recording). 
3.​ Adjust the knobs: 

○​ Offset: Tells the robot where in the sample to look for the master cycle. If the 
result sounds like a buzzsaw, move this until it sounds like a tone. 

○​ Mix: The magic slider. 



■​ 100% (Pure Robot): The audio is replaced by the perfect cycle. It sounds 
completely static, like a video game console. 

■​ 0% (Human): Just your original loop with a crossfade. 
■​ 50%: The "Freeze" effect. It keeps the texture of the real instrument but 

forces it to hold a steady pitch forever. 
○​ Step: How many cycles to grab. If the pitch detection is detecting an octave too 

high, increase this. 
○​ X-Fade: Smooths out the "Human" layer so it loops cleanly underneath the 

"Robot" layer. 

Why use this? To turn a short pluck (like a guitar or pizzicato string) into a long oscillator.. 

How to Use Morpher 

1.​ Select a Region: Loop the sustain part of your sample. 
2.​ Open the Tool: 

○​ Offset: Finds the fundamental cycle. Adjust this until the pitch matches your 
sample. 

○​ Morph (The Magic Knob): 
■​ 0%: Pure Robot. Just the raw, buzzy waveform cycle. 
■​ 100% (Spectral Lock): This is the money shot. It applies the frequency 

spectrum (the "sound") of your original sample onto the phase of the 
perfect loop. The result is a sound that has the rich character of a cello (or 
whatever) but is mathematically frozen in time. No wobbles. 

○​ Morph Timbre (Shift): Shifts the formants up or down. Makes a cello sound like 
a violin or a double bass without changing the pitch. 

○​ Morph Comb (Hollow): Adds a metallic, hollow texture. 
○​ Morph Gate (Dull): A spectral noise gate. Removes the "fizz" from the morphing 

process. 

Why use this? When the "The Infinite Sustain Synth" sounds too fake, but the original sample 
loops too poorly. This is the middle ground: Organic texture, Synthetic stability. 

The "Hipster" Section (Tunings) 
●​ Historic and World Tunings: 

○​ Menu: Notes -> Historic and World Tunings... 
○​ What it does: The EP only speaks 12-Tone Equal Temperament (Western 

standard tuning). This tool bakes microtonal tuning into the samples 
themselves. 

○​ Options: Just Intonation, Pythagorean, Meantone, Gamelan, etc. 
○​ Why? Because you watched one YouTube video about Adam Neely and now you 

think you're too good for standard tuning. No seriously, I wanted to add only a 



few of them pesky microtonal tunings. And guess what? The few turned into a 
few hundred (226 unique tuning presets at this moment) 

See more in the end section of this grandiose manual.  

The Loops and the Grid (For Those With No Rhythm) 
EP-40 allows you to play loops. Like forever. You can of course trigger loops in the other EPs 
too, but they won’t automatically loop. You need to trigger them manually.  

You think you can eyeball a perfect 4-bar loop. You can't. You'll be off by 10 milliseconds, and 
after four repetitions, your listener will feel a vague sense of anxiety they can't explain.​
Let the computer do the math. 

1. Detect the Tempo 

Click Region - Find BPM (From Length or Transients).  

“From Length” will use the length of the loop to determine BPM - provided that the loop is a 
loopable loop (like a professional sample loop) and so the length will actually determine the 
BPM. 

From Transients:  

The software analyzes the "Transients" (the loud bangy parts) to calculate the BPM. 

Find Beats 

●​ Note: It needs at least a few seconds of audio to work. Don't try to detect the BPM of a 
single snare hit. It will just laugh at you. 

●​ Result: It draws vertical lines on the waveform where it thinks the beats are. It also 
updates the Global BPM. 

2. Snap to Grid (The "Magnet") 

Menu Path: View -> Timeline -> Beats 

By default, the timeline shows Time (Seconds).​
Switch it to Beats (Bars). 

●​ What happens: The ruler at the bottom changes to 1.1, 1.2, 1.3.... 
●​ The Magnet: Now, when you drag a selection or a loop point, it snaps to the nearest 

16th note. 
○​ Why do I want this? It makes cutting perfect loops instant. No more zooming in to 

the pixel level to find the exact start of the bar. 



○​ Override: If you want to go off-grid (because you are "jazz" or something), hold 
Ctrl to temporarily disable the snap, or switch the View back to Time. 

Getting Audio IN  

Importing Kits (The "I Have Too Many Samples" Menu) 
Menu Path: File -> Import... 

You have gigabytes of drum kits from the 90s, Maschine groups you haven't used since 2015, 
and MPC programs you swore you'd listen to one day. You want them on your EP.​
Don't try to reconstruct them manually. I wrote code to parse that garbage so you don't have to. 

1. Import from Folder (Batch Processor) 

Menu Path: File -> Import -> Import Wavs from Folder... 

You have a folder on your hard drive called "Techno_Kicks_Final_Final_V3". You want them all 
in one instrument. 

1.​ Select the folder. 
2.​ The software grabs every WAV file inside. 
3.​ The Magic Logic: 

○​ Instrument Mode: If you were smart enough to name your files with notes 
(Bass_C2.wav, Bass_G2.wav), the software detects the pitch from the filename, 
sorts them, and maps them across the keyboard automatically. 

4.​ It converts everything to Mono/16-bit because, again, that is what the EP wants. 

2. Import Akai MPC Kit (.xpm) 

Menu Path: File -> Import ->  Import Akai Kit... 

So you’re moving from an MPC to an EP? Bold move. Hahahaha. ​
This imports .xpm program files. 

●​ Keygroups: If the MPC file was a keygroup instrument, it preserves the root notes and 
key ranges. 

●​ Drum Programs: If it was a drum kit, it maps the pads sequentially. 
●​ Warning: The EP only supports 8 regions per sample. If your MPC kit has 4 layers of 64 

notes velocity-switched nonsense, the software will import it, but it will yell at you to 
delete the extras before saving. 

3. Import Maschine Group (.mxgrp / .mxsnd) 



Menu Path: File -> Import ->  Import Maschine Group... 

Native Instruments loves to hide their files. This tool tries to find them. 

●​ It parses the mess inside .mxgrp files. 
●​ File Finding: Maschine files often have broken paths. The Editor attempts to find the 

audio by looking in \Samples subfolders or relative paths. If it can't find the WAVs, don't 
blame me, blame NI's file management. 

●​ It automatically converts those massive stereo samples down to the EP's native format. 

4. Import SmplTrek Kit (.stk) 

Menu Path: File -> Import -> Import SmplTrek Kit... 

I don't know why you have these, but I support them. Because I do have Smpltrek and I made a 
few good kits.​
The .stk format is a black box. This tool performs a Brute Force Extraction, ripping the WAV 
data directly out of the file and mapping it into a kit. It’s violent, but effective. 

 

CRITICAL WARNING FOR ALL IMPORTS:​
The EP hardware has a hard limit of 8 Regions (slices) per sample.​
Most imported kits (especially MPC/Maschine) will have way more than 8 samples. 

●​ The Editor will load them all so you can decide what to keep. 
●​ You must delete the extra regions (Right-Click -> Delete Region) until you have 8 or 

fewer. 
●​ If you try to save a kit with 16 regions, the software will unceremoniously truncate the 

extras. You have been warned. 

The Circular Loop Sampler (Continuous Flow Mode) 
Menu Path: Tools -> Circular Loop Sampler... 

If you've ever tried to record a perfect loop on a hardware sampler, you know the drill: Record. 
Miss the downbeat. Stop. Delete. Cry. Repeat.​
The Circular Loop Sampler is for people who are tired of crying. It runs a continuous timing 
grid based on your Tempo and Loop Size. It doesn't stop just because you messed up. 

How to Use It (The "Don't Stop" Method) 

1.​ Set the Grid: Set your BPM and the number of bars. Do this before you start playing, 
obviously. 



2.​ Press Record: The sampler starts looping. Every time it hits the end of the bar, it 
automatically shoves your last performance into a Take Slot and immediately starts 
recording the next one. 

3.​ Browse the Stack: Recorded 8 takes? Click through them. Statistically, one of them has 
to be less embarrassing than the others. 

4.​ Crossfade: This is the secret sauce. It blends the "tail" of the previous loop rotation into 
the start of the current one. 

○​ Why? Because a real instrument has decay. If you cut a cymbal crash at the end 
of a bar, it sounds unnatural. The software mixes that natural decay back into the 
start for a seamless, "no-click" transition. 

Click Load Selected Take and it will commit it to the main editor. Or don't. I'm not your boss. 

 

The Loop Maker (Beat Renderer) 
Menu Path: Tools -> Loop Maker (MIDI/MPC to wav) 

If you already have beats sequenced in a DAW or an MPC, stop trying to re-sequence them on 
the EP’s tiny screen with those chiclet keys. The Loop Maker takes your high-resolution MIDI or 
MPC Pattern files and "bakes" them into a single, perfectly looped WAV file using the drum kit 
you currently have loaded. 

How to Use It 

1.​ Load the Kit: You must have a drum kit (with regions mapped) loaded in the main editor 
first. The Robot needs to know what your "C2" kick drum actually sounds like before it 
can render it. 

2.​ Select the Pattern: Open a .mid or .mpcpattern file. 
3.​ Sync the BPM: Set the BPM to match your source project. The software uses this to 

calculate exactly how many samples long the loop should be. No guessing. 
4.​ Map your Pads: 

○​ Start Note: Usually C2 (MIDI 36). If your MIDI file assumes the kick is on C1, 
change this setting to align the notes with your drum regions. 

○​ Auto Map: Click this to let the software guess. It tries to align the MIDI file's 
notes to your Kit's root notes. It usually works. 

○​ Custom Mapping: For when "Auto Map" fails or you want to get weird. You can 
manually override specific triggers using this syntax: InputMIDI>TargetRoot​
Example: C2>A3, C#2>C4​
Translation: "When the MIDI file asks for C2 (Kick), play the Region rooted at A3 
(Snare)." 

5.​ Render: Click OK. 



The software will mix the samples. When you drop this file onto your EP, the hardware will see it 
as a "ready-to-go" loop with the correct BPM already baked in. No manual trimming required. 

Bonus Workflow: Chaos Theory 

Load a multi-sampled instrument that has nothing to do with drums (like a chopped-up vocal 
or a piano with 8 different notes).​
Then, load a Drum MIDI loop into the Loop Maker. 

●​ Result: A rhythmic, gated, melodic loop that follows the drum pattern but uses your 
weird samples. It’s instant IDM. You’re welcome. 

The Auto-Sampling Robot (Stealing Sounds is the new 
Orange) 
Menu Path: Tools-> MultiSample Robot... 

You have a synthesizer. It sounds great. You want those sounds inside your EP.​
Normally, this involves: pressing a key, hitting record, stopping, trimming start, trimming end, 
normalizing, assigning to a pad... and repeating that multiple times until you lose the will to live. 

The Auto-Sampling Robot does this for you. You tell it what to play, it sends MIDI notes to your 
synth, records the audio response, chopping it up into a perfect multi-sampled instrument while 
you go get a coffee. 

Remember: The EP, in its infinite glory, can only handle 8 regions. If you record 20 slices, the 
last 12 are going straight into the trash can. Of course, you can export it as an AKAI keygroup 
and play it on your MPC while contemplating why you bought the EP Audio Editor for all that. 

But wait, that’s not all. The total length of the sample (all 8 regions summed together) cannot 
exceed 20 seconds.​
If you were planning on capturing lush, 5-second reverb tails for every note, forget it. You will hit 
the EP limit before you finish the scale. Keep your release times short. 

The Cheat Code: If you absolutely need more time (and you don't mind a little dirt), use the 
Double Time trick. By speeding up the sampled result 2x and then pitching it down 12 
semitones, you can squeeze 40 seconds of audio into that 20-second slot. It sounds lo-fi, but 
beggars can't be choosers. See “The Repitch Tricks” 

 

1. The Setup  

This requires physical cables. I know, scary. 



1.​ Audio In: Connect your Synth’s Audio Output -> Your Computer’s Audio Input (like a 
USB audio interface). 

2.​ MIDI Out: Connect your Computer’s MIDI Interface OUT -> Your Synth’s MIDI Input. 
3.​ Select Devices: Pick the correct Audio Device and MIDI Device in the lists. 

○​ Tip: Use the "Test MIDI" button. If your synth doesn't beep, check your cables 
before you email me. 

2. The Parameters (Telling the Robot what to do) 

●​ Start / End Note: Don't be greedy. You have 8 regions in EP. Pick a useful range (like 
C3 to C5). 

●​ Sample Every X Semitones: The "lazy factor." 
○​ 1: Samples every single key. Memory suicide. EP can’t play it anyway, but go 

ahead. 
○​ 3: Samples every 3rd note. Good balance. 
○​ 6: Tritone. You get quite a range with 8 regions. 
○​ 12: Samples only octaves. The EP will pitch-shift the rest. Sounds "old school" 

(or bad, depending on your taste). 
●​ Velocity: How hard the robot hits the keys (1-127). 100 is usually loud enough. 
●​ Hold Time: How long the robot holds the key down (Sustain).  
●​ Wait After Release: How long the robot records after letting go of the key. Crucial if 

your patch has a long reverb or delay tail. If you cut this short, your reverb will sound 
chopped. 

●​ MIDI Channel: Matches your synth's receive channel. 

3. Signal Chain 

●​ Input Volume (Slider): This is a digital boost before recording. If your synth is quiet, 
crank this up. If you see the meter hitting red, turn it down. Digital clipping sounds like 
garbage. 

●​ Monitor Input: Check this box if you want to hear what you are recording through your 
computer speakers. Warning: If you are using a microphone, this will cause feedback 
and hurt your ears. I warned you. 

4. Processing Options 

●​ Normalize: Maximizes the volume of each slice after recording. Turn this on. Why would 
you want quiet samples? 

●​ Auto-Trim End: Detects when the sound actually stops (based on a silence threshold) 
and cuts the file there. This saves further editing. 

5. The Procedure 

1.​ Click Start Sampling. 



2.​ The Robot takes over. It creates a new project, clears the buffers, and starts the 
sequence. 

3.​ You will see a progress bar. Do not touch the computer. 
4.​ When finished, you will have a single WAV file with all the notes perfectly sliced into 

Regions with the correct Root Notes mapped. 

Note: If you panic, hit "Stop."  

6. The "Sweet Spot"  

Since you are mathematically limited to 8 regions, you can't just set the interval to "1" and hope 
for the best. Strategy, my Padawan!. See the APPENDIX.  

Note: If you run out of regions, the Robot stops. It doesn't care about your feelings. 

EP Connection (Hardware Purgatory) 
Menu Path: Tools -> EP View 

This mirrors the web interface  EP Sample Tool  

1.​ Plug in the USB cable. Try to find one that actually transmits data and isn't just for 
charging your vape. 

2.​ Open EP View. 
3.​ Click Connect and pray to the MIDI gods. 
4.​ Upload: When you drag a sample here, the Editor applies High-Quality Resampling. 

○​ Why care? I could have used linear interpolation (which is fast and trash), and 
you probably wouldn't have noticed. But I would have noticed 

 

Appendix  

The Microtonal & Historical Tuning Tool 
(Or: How to Sound Like You’re From 1695 or Outer Space) 

Menu Path: Notes -> Historic and World Tunings... 

The EP hardware is hardwired for 12-Tone Equal Temperament (the standard Western tuning 
where every key is equally out of tune). If you want to play Baroque harpsichord, Indian Ragas, 
or Gamelan music authentically, the hardware won't help you. 



This tool bakes the tuning directly into the samples. It takes your existing instrument, 
resamples each note by precise micro-cents, and maps them to the pads so that when you play 
a C Major scale, it comes out as "5-Limit Just Intonation" or "Maqam Bayati." 

Prerequisites (Read This First) 
1.​ You need a Multi-Sampled Instrument: This doesn't work well on a single drum hit. 

You need an instrument with multiple regions covering the keyboard range. (This could 
be more than the 8 allowed on EP) 

2.​ Set your EP to MAJOR SCALE: The tool maps the new tuning to the 8 pads of the 
Major Scale mode (C, D, E, F, G, A, B, C'). If you set your EP to Chromatic mode, the 
"in-between" notes (C#, D#, etc.) will just be standard 12-TET transpositions of the tuned 
notes, which might sound exceptionally weird. 

How to Use It 
1.​ Open the Dialog: Go to Notes -> Historic and World Tunings... 
2.​ Select a Preset: Browse the massive list of tunings. They are grouped by region and 

style: 
○​ Standards: 432Hz, Just Intonation (Pure Harmony). 
○​ Historical: Mean-tone (Renaissance), Werckmeister (Bach). 
○​ World: Maqam (Middle East), Raga (India), Gamelan (Indonesia). 
○​ Experimental: Partch, Wendy Carlos, Sci-Fi scales. 

3.​ Check the "Mapping Plan": The list on the right shows exactly what will happen. 
○​ Pad: Which key on the EP will play the sound. 
○​ Tune: How many cents (+/-) the sample will be shifted. 
○​ Quality: How much the audio quality will degrade (extreme shifts = lower quality). 

4.​ Audition (The Magic Button): 
○​ Check Audition Scale to hear a simple C-D-E-F-G-A-B-C run in the new tuning. 
○​ Check Audition Melody to hear a generated melody ("Jesu, Joy of Man's 

Desiring") in double voice, played with the new tuning. This lets you hear the 
harmonies and intervals in context. The song was purely chosen because it goes 
through all the notes of the scale and it is not copyrighted.  

5.​ Click OK: The software will process your entire instrument. It deletes the old regions and 
replaces them with 8 new, microtuned regions. 

Tuning Categories Explained 

The "I Want Pure Chords" Group 

●​ Just Intonation (5-Limit): The holy grail of harmony. Major chords (C-E-G) are dead 
silent and stable with no beating. 



●​ Meantone (1/4 Comma): The sound of the Renaissance. The "good" keys sound 
heavenly; the "bad" keys sound like a wolf howling. 

●​ Werckmeister III: The sound of Bach. A "Well-Temperament" that lets you play in all 
keys, but each key has a different emotional color. 

The "Middle Eastern / Maqam" Group 

These scales often use "Neutral Intervals" (quarter-tones) that don't exist on a piano. 

●​ Bayati: The most common Arabic Maqam. The 2nd note (E) is half-flat. 
●​ Hijaz: The "Aladdin" sound. A Phrygian dominant scale with a massive gap between the 

2nd and 3rd notes. 
●​ Saba: The "Weeping" scale. Deeply sad and unstable. 

The "Experimental" Group 

●​ Wendy Carlos Alpha/Beta: These scales don't have octaves. If you play a C, then a 
high C, they won't sound like the same note. They sound like aliens. 

●​ Harry Partch 11-Limit: Intervals based on the 11th harmonic of the overtone series. 
Sounds dissonant yet pure. 

●​ Binaural Beats: Detunes the samples slightly so that if you hard-pan two layers, your 
brain generates Alpha/Theta waves. (Requires stereo playback tricks). Of course, it's 
voodoo.  

Warnings 
●​ Destructive: This replaces your current regions.  
●​ Monophonic Mapping: Because this relies on repitching specific samples, it works best 

if you stick to the white keys (Major Scale mode). 
●​ Audio Quality: Converting a sample from C to a "Neutral Third" involves resampling. 

Extreme shifts (like the Gamelan scales) might introduce artifacts. The "Quality" column 
warns you about this. 

The Presets are categorized into the following groups: 

1. Standards & Just Intonation (4) 

●​ 12-TET (Reference) 
●​ 432Hz "Healing" 
●​ 5-Limit Just Intonation 
●​ 5-Limit Just Intonation (Natural Minor) 

2. Historical Western (Medieval to Classical) (17) 



●​ Pythagorean Tuning 
●​ Landini (Trecento) 
●​ Zarlino (Old Italian) 
●​ Ancient Greek Diatonic 
●​ Byzantine Chant 
●​ Musette de Cour 
●​ 1/4-Comma Meantone 
●​ Gottfried Silbermann 
●​ 1/8 Comma Meantone (Schismatic) 
●​ Werckmeister III 
●​ Kirnberger III 
●​ Kellner 
●​ Rameau (Temperament Ordinaire) 
●​ Vallotti & Young 
●​ Thomas Young Well Temperament 
●​ Neidhardt "Grosse Stadt" 
●​ Arnolt Schlick 

3. European Folk, Modal & Drones (68) 

●​ General/Celtic: Sea Shanty, Pirate Minor (Dorian), Hurdy-Gurdy, Georgian Polyphony, 
Cornemuse du Centre. 

●​ Iberian: Fado/Saudade, Cante Alentejano, Spanish Gypsy, Deep Flamenco, Basque 
Trikitixa, Galician Gaita, Asturian Gaita, Portuguese Gaita. 

●​ Central Europe: Cabrette, Zampogna, Hungarian Minor/Major, Hungarian Duda, Roma 
Cardas, Roma Manouche. 

●​ Slavic/Carpathian: Fujara, Czech Dudy, Polish Dudy, Hutsul, Lemko, Znamenny Chant, 
Kobzar, Kolomyjka, Belarusian Kupalye. 

●​ Balkans: Romanian Doina, Cimpoi, Transylvanian Major, Serbian Cocek, Serbian 
Gajde, Macedonian Oro, Croatian Dude, Albanian Lab, Bulgarian Paidushko, Bulgarian 
Women's Choir, Shopski, Thracian Gaida, Macedonian Gajda. 

●​ Greek: Rebetiko, Hitzaz, Greek Tsampouna. 
●​ Baltic: Sutartines, Latvian Dainas, Estonian Regilaul, Torupill. 
●​ Alpine/Med: Sardinian Tenores, Launeddas, Swiss Jodel, Corsican Paghjella, Sicilian 

Carrettiere. 
●​ Nordic: Hardanger Fiddle, Kulning, Swedish Polska, Sackpipa, Finnish Runosong, 

Faroese Kvaedi, Icelandic Rimur. 
●​ British Isles: Highland Bagpipe, Smallpipes, Irish Sean-nos, Welsh Penillion, English 

Folk, Cornish/Breton, Shetland Fiddle. 

4. Middle East & India (23) 

●​ Arabic/Turkish: Soft/Trad Quarter-Tone, Maqam Bayati, Nahawand, Saba, Sikah, Hijaz, 
Turkish Tulum, Egyptian Arghul. 



●​ Indian Ragas: Bhairav, Ahir Bhairav, Yaman (Calm/Bright), Todi, Marwa, Purvi, 
Experimental Shruti, Mashak/Titti. 

●​ Persian: Shur, Segah. 
●​ Jewish: Freygish, Mi Sheberach, Adonoy Molokh. 

5. Asia, Africa, Central Asia (21) 

●​ Japan: Hirajoshi, Miyako-bushi, Ryukyu. 
●​ China/Korea/Vietnam: Yayue, Pyongjo, Kyemyonjo, Vietnamese Bac, Vietnamese 

Nam. 
●​ Indonesia: Gamelan Slendro (Approx/Siwalik), Pelog. 
●​ Africa: Equi-Heptatonic, Ethiopian Tizita (Nostalgia/Major), Mandinka Kora, Shona 

Mbira, Tunisian Mizwad. 
●​ Central Asia: Tuvan Khoomei, Mongolian Urtyn Duu, Kazakh Dombra, Kyrgyz Komuz. 

6. Americas (42) 

●​ North American Folk: Andean Sikus, Appalachian Mountain Minor, Graveyard, Calico, 
Cumberland Gap, Ozark Modal, Sacred Harp, Field Holler, Spiritual, Cajun/Zydeco, 
Tejano Conjunto, Quebecois, Clawhammer Banjo. 

●​ Indigenous North: Lakota Flute, Navajo, Plains Nations, Cherokee, Iroquois, Potlatch, 
Inuit Katajjaq. 

●​ Mexico/Central: Son Jarocho, Mayan, Garifuna. 
●​ Caribbean: Steel Pan, Cuban Son, Haitian Vodou, Jamaican Nyabinghi, Puerto Rican 

Bomba, Dominican Palo. 
●​ South America: Peruvian Huayno, Bolivian Tarkeada, Argentine Tango, Brazilian Baiao, 

Choro, Candomble, Venezuelan Joropo, Colombian Cumbia, Amazonian. 

7. Oceania (17) 

●​ Polynesia: Hawaiian Slack-Key, Oli, Maori Taonga Puoro, Tahitian Himene, Samoan 
Pese, Tongan Lakalaka. 

●​ Melanesia/Micro: PNG Highlands, Solomon Are'are, Fijian Meke, Vanuatu Tam-Tam, 
Chuukese, Palauan, Chamorro. 

●​ Australia: Yolnu Manikay, Didgeridoo/Yidaki, Central Australian, Torres Strait. 

8. Jazz, Blues & Theory (14) 

●​ Major/Minor Pentatonic, Septimal Blues, Coltrane Augmented, Bebop Dominant, Delta 
Blues, Acoustic Guitar Sweetener, Piano Stretch (Railsback), Honky-Tonk, Brass 
Harmonics, Choir/Barbershop, Messiaen Mode 3, Altered Scale, Lydian Dominant. 

9. Experimental & Sci-Fi (24) 



●​ Octatonic, Whole Tone, Lofi/Tape Warp, Scriabin Prometheus, High-Limit JI, 19-TET, 
Spectral Harmonics 8-16, Euler's Genus, Golden Ratio (Phi), La Monte Young, Verdi 
Enigmatic (Standard/432Hz), Bohlen-Pierce, Wendy Carlos (Alpha/Beta/Gamma), Harry 
Partch (Otonality/Utonality), Erv Wilson Hexany, 22-TET, Binaural Beats 
(Alpha/Theta/Beta), Uncanny Valley. 

 

The "Sweet Spot" Cheat Sheet 
Since you are mathematically limited to 8 regions, you can't just set the interval to "1" and hope 
for the best. Strategy, my Padawan!. Here are the settings I use to get the most playable range 
out of specific instruments. 

Instrument Start 
Note 

Sample 
Every 
(Interval) 

Range 
Covered 

Why? 

Bass C1 
(24) 

3 (Minor 
3rd) 

C1 to C3 Bass lines live in the basement. If you are 
playing a bass solo in the 5th octave, you 
need a therapist. This gives you a high-detail 
low end. 

Leads / 
Synths 

C3 
(48) 

4 (Major 
3rd) 

C3 to 
G#5 

Covers the main melody range. The pitch 
shifting is minimal (max +/- 2 semitones), so it 
won't sound like a drunk chipmunk. 

Pads / 
Strings 

C2 
(36) 

6 (Tritone) C2 to C6 Pads tolerate pitch-shifting better than plucks. 
A Tritone interval gives you a massive 
4-octave range with only 8 regions. 

Piano / 
Keys 

C2 
(36) 

5 (Perfect 
4th) 

C2 to 
G#5 

You aren't playing Rachmaninoff on a 
calculator. This covers the chords and the 
melody range decently well, though stretching 
a piano by 5 semitones starts to sound a bit 
like a flea-market CASIO. Since the piano has 
a nice decay, capture longer tails and then 



use the Double Time trick to fit it all in the 20 
sec EP limit. 

808s / 
Subs 

C1 
(24) 

2 (Whole 
Tone) 

C1 to E2 For 808 glides, you want maximum resolution 
in the sub frequencies. Don't stretch subs too 
far or they turn into sub-mud. 

"Old 
School" 

C0 
(12) 

12 (Octave) C0 to C8 Covers the entire MIDI board. It will sound lofi 
and crunchy between the octaves. Some 
people pay extra for that sound.  

Here is the Orchestral cheat sheet. Orchestral instruments are the hardest to sample because 
if you stretch a violin too far, it sounds like a mosquito. If you stretch a tuba, it sounds like a 
dying cow. You have to be careful. 

Instrument Start 
Note 

Sample 
Every 

Range 
Covered 

Why? 

String 
Sections 

C2 
(36) 

6 
(Tritone) 

C2 to C6 Ensembles are forgiving. A Tritone interval 
gives you the full range from Cello lows to 
Violin highs in exactly 8 regions. Acceptable for 
cinematic pads. 

Solo Violin G3 
(55) 

3 (Minor 
3rd) 

G3 to G5 Solo strings sound fake immediately if you 
stretch them just a semitone. This covers the 
"money range" of the violin, but you probably 
won’t get any money for this one. 

Solo Cello C2 
(36) 

4 (Major 
3rd) 

C2 to E4 The cello relies on body resonance. Stretching 
it more than a Major 3rd destroys that woody 
texture and makes it sound like a plastic 
garbage disposal. 



Brass 
Section 

C2 
(36) 

5 
(Perfect 
4th) 

C2 to 
G#5 

Brass has complex overtones. A Perfect 4th is 
the maximum stretch before it starts sounding 
like Cranky Man playing a kazoo ensemble. 

Trumpet F#3 
(54) 

3 (Minor 
3rd) 

F#3 to F5 Trumpets are formant-sensitive. Do not get 
greedy here. 3 semitones max, or it will sound 
like a synthesizer from 1992. Well, it will 
probably sound like it anyway.  

Synth 
Choir 

C3 
(48) 

4 (Major 
3rd) 

C3 to 
G#5 

Human voices are the first thing the ear 
detects as "fake." Synth choirs already sound 
fake so you can afford to have a little range. 

Choir 
(Realistic) 

C3 
(48) 

2 (Whole 
Tone) 

C3 to D4 You only get about one octave of playable 
range with 8 regions, but at least it won't sound 
like a helium accident. 

Women's 
Choir 

C4 
(60) 

2 (Whole 
Tone) 

C4 to E5 High risk. Female voices are unforgiving. For 
female vocals, the "formant shift" (the 
chipmunk effect) happens even faster than with 
male voices. Pitching them down adds a weird 
"masculine" grogginess, and pitching them up 
turns them into Mickey Mouse Pixies. An 
interval of 2 is the absolute maximum safety 
limit.  

Orch Hits / 
Stabs 

C3 
(48) 

6 
(Tritone) 

C3 to C7 It's a stab. It’s supposed to sound sampled and 
gritty. You can get away with murder here, but 
be warned: an orchestral hit at C7 doesn't 
sound "Epic," it sounds like a Hitchcock movie.  

Flutes / 
Winds 

C4 
(60) 

3 (Minor 
3rd) 

C4 to C6 Wind instruments sound terrible when 
stretched. Keep the intervals tight if you want it 
to sound like a flute and not a penny whistle. In 



EP-1320 Medieval they sampled almost every 
semitone in the sweet spot.  

 

 

Keyboard Cheat Sheet  
Key Result 

Space Play/Stop (The only button you will actually use) 

L Toggle Looping 

I / O Set Loop In / Out points. 

Ctrl + A Select All. 

Ctrl + Z Undo (The "I messed up" button). 

Ctrl + Del Deletes wave data inside the selection. 

Home Set playhead to start. 

Scroll 
Wheel 

Zoom. 

Alt + Scroll Scroll sideways. 

Single 
Click 

(On Region Header) Selects that region. 

Double-Cli
ck 

(On Waveform) Selects the region under mouse.<br>(On Piano Roll) 
Expands/Collapses the piano view. 
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